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Submission Guidelines
TYPES OF SUBMISSIONS
Archaeology of Food and Foodways accepts submissions of original Research Articles, Thematic Essays, Applied
Articles, Photo Essays, and Thematic Issues. All submissions must have an archaeological focus, but may elucidate
experimental archaeological or ethnoarchaeological work if applied to a specific archaeological problem, or
incorporate archaeological research into contemporary applications. Submissions may have any geographical
focus. AFF does not publish short notes, descriptive excavation reports, limited artifact studies, or book reviews.
Research Articles
We publish submissions of original research by archaeologists, historians, Classicists, and other scholars who
address methodologies, historical trajectories, cross-cultural comparisons, and controversies surrounding
material culture and past foodways. We welcome submissions that make use of any form of material culture or
scientific methodologies, covering time periods from prehistory through the end of the 19th century. Papers of a
more methodological focus will also be considered as long as they have an archaeological basis. Research Article
submissions may include up to 8 images and should include 6,000-12,000 words of text, excluding bibliography,
abstracts, and photo captions.
Thematic Essays
We publish submissions of original work by scholars addressing theoretical convergences, historical trajectories,
paradigmatic shifts, broad cross- cultural comparisons, and debates in foodways scholarship. As with Research
Article submissions, these contributions should address approaches to foodways in time periods from prehistory
through the end of the 19th century. Thematic Essay submissions may include up to 8 images and should include
6,000-12,000 words of text, excluding bibliography, abstracts, and photo captions.
Applied Articles
We also encourage the submission of work by scholars and other specialists who have applied archaeological
findings to such domains as public policy, culinary arts, tourism industries, food revitalization projects, religious
practice, and dietary regimes. Applied Articles may include up to 8 images and should include 4,000-10,000
words of text, excluding bibliography, abstracts, and photo captions.
Photo Essays
We publish photo essays that document experimental archaeology, ethnoarchaeology, and applied ethnography
to enhance understandings of foodways in the past or demonstrate applied techniques formulated through
archaeological research. Photo Essay submissions may include up to 20 colour or black and white images, and
should include 2,000-3,000 words of text, excluding bibliography, abstracts, and photo captions.
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Thematic Issues
We welcome invitations to publish thematic issues of the journal. Special issues or special clusters within the
usual journal format will focus on a particular thematic interest, and include 3-7 articles in total. These articles
must follow the submission guidelines above for Research Articles, Thematic Essays, Applied Articles, and Photo
Essays. Thematic organizers interested in this type of submission must approach the Editors prior to submission.
MANUSCRIPT
Manuscripts should contain the following elements:
Form of the manuscript - The manuscript should be in Microsoft Word document file format. The text is singlespaced; uses a 12-point font; and employs italics rather than underlining (except with URL addresses). All pages
should be numbered consecutively and all lines should be numbered (see additional guidelines below for details).
All images should be included in the article as low-resolution images for the purposes of review, see ‘Captions’
below for further information on how they should be presented within the document. NOTE: On acceptance you
will be required to upload hi-resolution versions.
Your submission should be in English or if not, the Editor has previously agreed to seek a reviewer who is able to
review your paper. You understand that ultimately the paper will be published in English and you will need to
arrange for the translation which will then be subject to approval by the Editors.
Manuscripts should normally include the following elements in this order:
1.

Title, Name and Affiliation - Full title of the article, your name(s), your academic address (including
department, institution, city, and country) and your e-mail address should be included on the first page,
as follows:
Full title of the article (boldface)
Erica Rowan, Department of Classics, Royal Holloway, University of London,
Egham, United Kingdom Email: Erica.rowan@rhul.ac.uk

2.

Main text - Begin on a new page and include title/subtitle, abstract and keywords followed by the
main text. Use boldface, italics, and then underline to distinguish consistently between primary,
secondary and tertiary headings. You may also use Headings 1, 2 and 3 in MS- Word. All images
should be included in the article as low-resolution images for the purposes of review, see ‘Captions’ below
for further information on how they should be presented within the document.

3.

Abstract - An English-language abstract of up to 300 words must be included as noted above. We
welcome the submission of a second abstract in a language other than English. Special character sets
(Cyrillic, Korean, Arabic, etc.) may require the upload of the secondary abstract as an image.

4.

Keywords - list up to six keywords that adequately capture the main elements of your paper.

5.

Footnotes - Use only footnotes that are essential, and make them as concise as possible.

6.

References (for full details see separate section below) - A formatted list of references MUST be included
as part of the main article and should include URLs and DOIs when available. A copy can also be inserted
in the metadata section under the references tab, but this is optional.

7.

Captions - If not already inserted in the main body of the text alongside each corresponding
table/figure/image etc, authors should provide a list of captions on a separate page following the
References section. This section will list captions for all tables and figures (i.e. all artwork, including
photographs, drawings and graphs).
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8.

Acknowledgements – Place these on a separate page after the main body of the text.

9.

About the author – Place after the Acknowledgements. Include your current institutional affiliation (if
applicable) along with a brief 2-3 sentence statement summarising your research interests and any areas
of specialization.

Ensuring a Blind Review - To ensure the integrity of the blind peer-review process for submission to this journal, every
effort should be made to prevent the identities of the authors and reviewers from being known to each other. This
involves the authors, editors, and reviewers (who upload documents as part of their review) checking to see if the
following steps have been taken with regard to the text and the file properties:
•

The authors of the document have deleted their names from the main text, with "Author" and year used in the
references and footnotes, instead of the authors' name, article title, etc.

•

With Microsoft Office documents, author identification should also be removed from the properties for the file
(see under File in Word), by clicking on the following, beginning with File on the main menu of the Microsoft
application: File > Save As > Tools (or Options with a Mac) > Security > Remove personal information from file
properties on save > Save.

•

With PDFs, the authors' names should also be removed from Document Properties found under File on Adobe
Acrobat's main menu.

FIGURES AND TABLES
Figures - Labelling should be of professional standard and no less than 2 mm high after final reduction.
Include a scale when objects, sections, etc. are illustrated, and both a scale and a north arrow on all maps. All
scales, symbols and keys should be included as part of the figure itself, rather than placed in the caption. Every
figure must have a brief caption, correspondingly numbered, which will be printed beneath the figure: do not
include the caption on the actual figure. Cite all illustrations as Figures (not plate, map, plan, illustration, etc.).
Indicate in the text where each Figure (or Table) should appear, by writing on a separate line ‘Insert Figure xx
about here’ at the appropriate point. Figures should initially be submitted in a low-resolution format as either
.jpg or .tiff file. Figures and Tables should be numbered in the order of their first appearance in the text.
Tables - When designing tables, bear in mind their size relative to the dimensions of AFF’s standard page
size (149 x 204 mm). Complex or lengthy tables are best submitted as camera-ready copy; otherwise, present
all tables in 1.5-spaced type, together with a complete, separate list of table captions. As noted above,
figures and tables should be numbered in the order of their first appearance in the text.
Electronic files: hi-res (uploaded after manuscript acceptance) - These may be greyscale, black and white, or
full colour; authors are encouraged to use colour wherever appropriate. Figures should initially be submitted in a
low-resolution format as a .jpg file. For eventual publication, they must be high-resolution (i.e. 300 dpi for photos
and 600 dpi for black-and-white line-drawings at a maximum width of 149mm) and submitted in .jpeg format.
Note that the high-resolution (large-size) files should not be e-mailed but must instead be uploaded to a website
(specific instructions will follow once your manuscript is accepted for publication). Please note that all artwork
must be submitted in digital format; any author experiencing difficulties in submitting digital artwork should
contact the editors.
OTHER ELEMENTS OF THE MANUSCRIPT
Numbers - Spell out numbers one to nine; express all numbers greater than nine with Arabic numerals, i.e. 10 to
999,000, etc. Spell out ‘million’ or ‘billion’, numbers that begin sentences, and those used in a general sense in
narrative, e.g. ‘thousands of sherds’.
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•
•

In a sequence of numbers, the last two digits only should be given in the second element, except when
the first of the two would then be a zero, thus: 153-79 (not 153-179), but 107-109 (not 107-09).
th
th
For dates and times, follow these examples: 40 hours; 30 October 1997; 18 Dynasty; 16 -century
nd
buildings (hyphenated); 2 century (rather than second century); 1980s (no apostrophe); 1978-79 (not
1978-9); 333BC, AD180, 85-135 AD (no periods in BC or AD); spell out all ordinal numbers.

Spelling - Either British or American spelling may be used, but do not mix these spelling conventions.
Radiocarbon dates - Radiocarbon determinations should be cited in full, with laboratory reference, age
determinations in Cal BC (using latest radiocarbon calibration curves) if possible; otherwise in 14C years BP
(Before Present, deemed to be AD 1950), and 1-sigma (68.2%) measurement error estimate (e.g. OxA- 1083, 4370
± 90 BP). Any recent laboratory determination will have been corrected for isotopic fractionation (δ13C), but in
cases of unusual δ13C values, or determinations run some years ago when such correction may not have been
carried out by the producing laboratory, this should also be mentioned. Calendar dates refer either to historical
dates, or calibrated calendar date estimates for radiocarbon determinations. The convention is:
•
Calibrated dates Cal BC/Cal AD
•
Historical dates BC/AD
•
Calibrated date estimates should cite the specific calibration curve, and computer program, used
to obtain the estimate. For further information and guidance, see http://c14.arch.ox.ac.uk .
Quotations - If more than four lines are quoted, indent from left margin, but continue to use double- spacing.
Otherwise, quotes should be enclosed in double quotation marks, single quotation marks being used only for
quotes within a quotation.
Italics and accents - Type in italic foreign words that are to be printed in italic (including et al.), but note that
such common abbreviations as e.g., cf., etc., are not italicized. In both the text and references, titles of all journals,
monographs, books, and other such publications should be italicized. Non- Roman scripts (e.g. Greek, Arabic,
Hebrew, Cyrillic) should be transliterated; diacritical marks and accents should be indicated for foreign words.
Abbreviations - Use sparingly. True abbreviations should always end with a full-stop, but contractions should not
(e.g. rep., ed.; but edn, Mr, Jr); plural abbreviations are not regarded as contractions (e.g. chs., eds.). Very common
abbreviations, such as BC, AD, PhD, UK, should not be punctuated. Names of states in the USA should be written
out in full, rather than abbreviated (e.g. Vermont, not VT). When some time period, artefact type, or similar
designation is used frequently within the text, give the full spelling initially, followed by an abbreviation in
parentheses that should be used thereafter. Examples: Iron Age (IA). AFF does not use any abbreviations for titles
of periodicals or standard reference works: these should always be written in full.
Supplementary Files (optional)
Supplementary files, to be posted online and linked to the publication, are welcome and encouraged. Any
supplementary/additional files should be uploaded separately and/or a link provided. Ideally the supplementary
files will be cited in the main text.
e.g. Supplementary file 1: Appendix. Archaeobotanical data related to the study.
These files will not be typeset and so must be provided in an easily accessible form.
Examples of supplemental file formats:
•
Comma separated value files (.csv)
•
Microsoft formats: Excel (.xls, .xlsx), PowerPoint (.ppt, .pptx), Word (.doc, .docx)
•
Video/Animation formats: .avi, .mpg and .mpeg, .mov, .qt, .swf, .wmv
•
Vector graphics: .eps, .pdf
•
3D models: 3D PDF

4|Page

•
•

GIS raster and vector files
Google Earth files: .kmz, .kml

They will be assigned a DOI and linked from the publication.
REFERENCES
All references cited within the manuscript must be listed at the end of the main text file. A formatted list of
references can also be inserted separately to the metadata section under the references tab and should include
URLs and DOIs when available. Please use the The Chicago Manual of Style author-date referencing system.
References should appear as in-text citations. Consult the latest edition of The Chicago Manual of Style for any
conventions not specifically covered in these Guidelines.
In-text Citations
•
(Jones 2007: 89)
•
Jones (2007: 89) states that…
•
(Wilkins 1973: 192-99; 1976: 91-97, 101-105) [separate all references, even if by the same author, with semicolons]
•
(Jones 2007: 90; Wilkins 1973: 192-93) [authors should be listed in alphabetical order]
•
(Renfrew and Cooke 1979: 221)
•
(Renfrew et al. 1965: 225-30) [use et al. for more than two authors]
•
(Smith 1984a; 1984b) [separate each citation with a semi-colon]
•
(Davis and Lewis 1985: 86, fig. 5, nos. 7-10)
Ancient and Classical Authors and Texts
References to ancient and classical authors must not be abbreviated at any time. Even if only one text of any
given author is referred to in this paper, use both the author’s name and the title of the work in the in-text
citation.
•
Use Arabic numerals only in references to specific text passages, separated by a full stop without
•
space (e.g. 3.2.12-14)
•
In the bibliography use English versions of the author’s name and title of the text if these are commonly
used: good guidance is offered by the names and titles as used by the editions of the widely available
editions of the Loeb Classical Library (London: Heinemann; http://www.hup.harvard.edu/loeb/index.html).
•
Some examples that show how to list classical authors and texts:
o
Appian, Roman History Book 8: Punic Wars.
o
Caesar, Bellum Africanum. Dio Chrysostom, Discourses. Homer, Odyssey.
o
Ovid, Fasti.
o
Pliny the Elder, Naturalis Historia.
o
Plutarch, The Parallel Lives: The Life of Cato the Elder.
o
Polybius, Histories.
Reference List
When the same author is cited more than once, repeat the name, and list publications in chronological order
from earliest to most recent. List multiple authors or editors in full unless there are more than 10 authors (i.e. use
et al. only in the text, and not in the references). Give both place of publication and publishers’ names, using the
full version: e.g. Basil Blackwell, Cambridge University Press, (but do not include & Co., Ltd., Inc., etc.). Titles of
books and journals should be italicized; titles of dissertations and theses are not italicized; titles of articles in
journals or in books should be capitalized and placed within quotation marks. Note that this applies primarily to
English-language publications and that other languages may have slightly different conventions that should be
used instead. Titles of publications that do not use the Roman alphabet should, whenever feasible, be given in
the original (e.g. in Greek, Turkish, Hebrew). Some examples are given below while additional examples can be
found at https://www.chicagomanualofstyle.org/tools_citationguide/citation-guide-2.html#cg-book
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Books
Hastorf, Christine A. 2016. The Social Archaeology of Food: Thinking about Eating from Prehistory to the Present.
Cambridge, UK: Cambridge University Press.
Book chapters
Lissarrague, François. 2015. “Art and Images: Feasting in Ancient Greece and Rome.” In A Companion to Food in
the Ancient World, edited by John Wilkins and Robin Nadeau, 123-131. Oxford: Wiley-Blackwell.
Journal articles
Frink, Lisa. 2007. "Storage and Status in Precolonial and Colonial Coastal Western Alaska." Current Anthropology 48
(3):349-374. https://doi.org/10.1086/512997
Conference papers
Lentz, David L. 2001. "Diets Under Duress: Paleoethnobotanical Evidence from the Late Classic Maya Site of
Aguateca." The 66th Annual Meetings of the Society for American Archaeology, New Orleans, LA.
Organisational publications/Grey literature/Reports
Sheets, Payson D., David L. Lentz, Christine C. Dixon, A.P. Tetlow, and Angela Hood. 2010. Report of the 2009 Maya
Agriculture Project, South of Joya de Cerén, El Salvador. Boulder, CO: University of Colorado, Boulder.
Theses and dissertations
Farahani, Alan. 2014. "Sustaining Community under Empire: An Archaeological Investigation of Long-Term
Agricultural Production and Imperial Interventions at Dhiban, Jordan, 1000 BCE-1450 CE." PhD Dissertation,
University of California, Berkeley.
Website
Klumpp, Andreas. 2015. "Küche und Kochen im Wandel der Zeit / Kitchens and Cooking through the Ages."
Culina Historica: Möglichkeiten und Grenzen der Rekonstruktion einer historischen Geschmackswelt /
Possibilities and Problems in Reconstructing a Historic World of Taste, accessed October 29. http://culinahistorica.blogspot.ca/2015/10/kuche-und-kochen-im-wandel-der-zeit.html.
ADDITIONAL GUIDELINES
•

You have read and agree to our statement of ethical practice, your legal responsibilities as author, and
understand the copyright will be transferred to the publisher. Click here to view our Statement of Ethical
Practice and Copyright Notice.

•

The instructions in 'Ensuring a Blind Review' have been followed.

•

Any illustrations, figures, maps, or photographs are either your property or you have cleared all
permissions for publication without restriction. You will be asked to provide documentation of
copyright permissions with final submission of an accepted paper.

•

How to add line numbers to your Word document:
1.
2.
3.
4.

On the Page Layout tab, in the Page Setup group, click on the Line Numbers icon.
Click Line Numbering Options, and then click the Layout tab.

In the Apply to list, click Whole document from the dropdown menu and then click on Line Numbers tab, tick add
line numbering and restart each page.
Click OK to close.
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